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1. Introduction

Merci du temps que vous allez consacré & I'évaluation de Formula One e.Report Designer. Ce document a été congu pour
donner au lecteur un apergu général des fonctionnalités du logiciel en une trés courte période de temps. Les étapes dans ce
guide vous prendront approximativement 30 minutes.

Formula One e.Report Designer est un outil flexible et convivial dédié aux développeurs qui ont besoin d’agréger des
informations d’affaires depuis des sources de données diverses, et de publier les données sur le Web sous forme de rapports
professionnels.

Formula One e.Report Designer permet aux développeurs d'extraire, de formater et de générer efficacement des données.
Formula One e.Report Designer accéde aux données depuis une variété de sources, incluant les objets Java au sein
d’applications, XML, les bases de données, les EJBs (Enterprise JavaBeans), et les fichiers texte. Les développeurs peuvent
alors formater les données de multiples fagons grace aux assistants intuitifs et a un éditeur WYSIWYG complet. Finalement,
I'outil peut générer le contenu dans de nombreux formats visuels et d'impression.

Le logiciel Formula One e.Report Engine inclut un environnement de conception visuel (Designer) et une APl (Engine).

2. Avant de Démarrer

Avant toute chose, vous devez installer la version d’évaluation de Formula One e.Report Designer (limitée a 30 jours) sur votre
machine. Les instructions qui suivent vous guideront au travers des différentes étapes nécessaires pour l'installation sur les
plates-formes Win32.
Pré-requis pour la version d’évaluation (et non pas les pré-requis généraux pour le produit en version définitive) :

Systéeme d’exploitation Win32 (pour utiliser la plate-forme Java fournie)

Navigateur Web Standard (pour visualiser les sorties e.Report au format DHTML)

Reader Adobe Acrobat (pour visualiser les sorties e.Report au format PDF)
Avant de commencer I'évaluation, vous devez :

1 - Installer Formula One e.Report Designer

2 - Créer une connexion ODBC qui référence les données fournies en exemple

Etape 1: Installation de Formula One e.Report Designer

Option 1 :

Téléchargez une copie d'évaluation de Formula One e.Report Engine (qui inclut e.Report Designer sur le site de
KAPITEC SOFTWARE) :

http://www.kapitec.com/downloads/ReportingEngines/ReportingEngines.htm

Sélectionnez la version d’évaluation de Formula One e.Report Engine
Téléchargez le fichier FormulaOneERD-Evaluation.exe (taille approximative 98 Mo) et mettez-le directement sur le C:\
Installez Formula One e.Report Designer :

Double-cliquez sur C:\FormulaOneERD-Evaluation.exe

©2004 - KAPITEC SOFTWARE S.A.S. - Tous droits réservés - www.kapitec.com
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Une fois linstallation terminée, un nouveau répertoire est créé : C:\Program Files\Formula One\F1eRE7-Eval. Ce répertoire
contient tout ce dont vous avez besoin pour exécuter le Designer, comme les fichiers JAR de I'Engine, les manuels PDF, le
Javadoc, et toute une série d’exemples de code.
Option 2 :

Installez Formula One e.Report Designer & partir du CD-ROM d’évaluation Formula One Reporting (Formula One
e.Report Engine) qui vous a été fourni. Merci de vous référer aux instructions décrites ci-dessus.

Etape 2 : Configuration du Driver ODBC pour la Base de Données du Guide
d’Evaluation

Certains des rapports utilisent un driver ODBC pour accéder a une base de données Microsoft Access. Si vous voulez évaluer
les possibilités de reporting du logiciel a partir de sources de données relationnelles, il vous faut suivre ces étapes :

Sélectionnez Démarrer / Paramétres / Panneau de Configuration / Outils d’administration / Sources de données (ODBC)
Cliquez sur Sources de données systeme / Ajouter...

Sélectionnez Microsoft Access Driver (*.mdb) / Terminer

Saisissez sfdata comme nom de la source de données

Cliquez sur Sélectionner le répertoire... et naviguez jusqu’au fichier sfdata.mdb se trouvant dans C:\Program
Files\Formula One\F1eRE7-Evalfiles\data

Cliguez sur OK/OK /OK

3. Démarrage de Formula One e.Report Designer

Pour lancer Formula One e.Report Designer depuis le menu Démarrer, sélectionnez Démarrer | Programmes | Formula One |
Formula One e.Report Designer 7 - Evaluation. Cela invoque le fichier script run.bat, qui se trouve dans le répertoire C:\Program
Files\Formula One\F1eRE7-Eval\bin directory. Quand une template de rapport est créée dans le Designer, elle est stockée dans
un fichier de définition de rapport appelé conception de rapport (report design). Ce fichier a pour extension .jod.

©2004 - KAPITEC SOFTWARE S.A.S. - Tous droits réservés - www.kapitec.com
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4. Chargement et Visualisation de Rapports

Formula One e.Report Designer vous permet de concevoir et de formater visuellement votre rapport. L'interface utilisateur est
trés similaire & celles trouvées dans Microsoft Access. Pour charger un des exemples de rapports, sélectionnez File | Open a
partir du menu. Naviguez jusqu’au répertoire C:\Program Files\Formula One\F1eRE7-Eval¥iles\designs\sfdata et sélectionnez le
fichier de conception de rapport charts.jod. Ce fichier montre & quoi ressemble un exemple de rapport avec des courbes et des
graphes, et comment il fonctionne dans Formula One e.Report Designer.

Afin de visualiser comment les données du rapport vont apparaitre pour la conception du rapport, cliquez sur 'onglet Preview
(Apercu) situé en haut du rapport. Le rapport est alors généré et s’affiche dans la fenétre Preview.
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Formula One e.Report Designer vous permet de prévisualiser votre rapport.

C’est le processus de base que vous utilisez pour développer vos rapports. Une fois les changements effectués a la conception,
vous devez prévisualiser dans la fenétre Viewer. Sivous avez déja exécuté le rapport, vous devez cliquer sur l'icéne Refresh
(Rafraichir) dans la barre de menu de la fenétre Viewer de e.Report Designer ou sélectionner le menu View -> Refresh.

5. Fenétre Viewer

L’'onglet Preview de Formula One e.Report Designer utilise le module Viewer pour visualiser et exporter les rapports. Le module
Viewer peut également étre utilisé dans votre propre application Java SWING.

La barre d’outils fournit de nombreuses options pour naviguer dans le rapport (Suivant / Précédent / Début / Fin). De plus, vous
pouvez aussi aller a un numéro de page spécifique dans un rapport (Survol de chaque icone de la barre d'outils avec la souris
pour avoir une description de chacune des fonctions des icbnes sous forme de menu pop-up).

Vous pouvez aussi faire des zoom avant et arriere pour visualiser les données du rapport en choisissant le facteur de zoom
dans la barre d’outils (facteur de 50% a 200% de la taille du rapport). Vous pouvez scroller 'écran en utilisant les ascenseurs ou
en cliguant et glissant la fenétre.

Les regles en haut a gauche du rapport indiquent la taille réelle du rapport. Cette information est trés souvent utile lors de la
configuration d’un rapport pour s’adapter a un format spécifique de papier ou pour que le rapport s’affiche correctement une fois
exporté dans plusieurs formats de fichiers. La page courante et le nombre total de pages du rapport sont affichés en bas a
gauche de la fenétre Viewer.

©2004 - KAPITEC SOFTWARE S.A.S. - Tous droits réservés - www.kapitec.com
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6. Table des Matieres / Zoom Avant

L’icone de la Table des Matiéres (Table of Contents - ToC) dans la barre d’outils est d’un intérét particulier. En cliquant sur cette
icéne on affiche ou on cache la fenétre Table des Matiéres. La fenétre Table of Contents apparait a gauche de la fenétre de
visualisation avec une structure arborescente.
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Formula One e.Report Designer génére automatiquement une Table des Matiéres.

Cette structure arborescente représente la "structure" de votre rapport. Une structure de rapport comprend les différentes
Sections des rapports, avec des Groupes et les zones En-téte/Pied-de-page.

La Table des Matieres facilite la visualisation et I'analyse de rapports importants ayant de multiples niveaux. En cliquant sur un
élément, on affiche ses données liées sur le c6té droit de la fenétre. Une barre de séparation sépare les fenétres Table of
Contents et Viewer. Les fenétres peuvent étre redimensionnées a la souris.

La Table des Matiéres est un mécanisme dans lequel la fonction Zoom Avant (Drill Down) est fournie. Le comportement de la
fenétre ToC/Drill Down peut étre configuré dans la fenétre du Designer depuis le menu Tools | Options | Drill Down. Vous
pouvez choisir si vous voulez afficher des résumés et/ou des détails. Vous pouvez aussi choisir les niveaux de Table de
Matiéres que vous voulez afficher.

7. Impression et Exportation de Rapports

Peu de rapports sont de grande utilité sans la possibilité de les générer dans des formats que les autres utilisateurs peuvent
visualiser et imprimer. Pour imprimer le rapport, cliquez sur l'icdne Print (Impression) dans la barre d’outils de la fenétre Viewer.
La bofte de dialogue de I'imprimante s’affiche alors. Si 'imprimante par défaut est la bonne, cliquez sur OK, et le rapport sera
imprimé sur l'imprimante spécifiée.

Formula One e.Report Designer peut également exporter le rapport dans des formats variés tout en conservant la plupart des
informations sur le formatage du rapport, telles que les couleurs, les polices, la mise en page, etc. Les utilisateurs peuvent
exporter leurs rapports dans des formats PDF, DHTML, XML, Excel, et CSV. Pour exporter votre rapport, cliquez sur l'icbne

©2004 - KAPITEC SOFTWARE S.A.S. - Tous droits réservés - www.kapitec.com
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Generates output in different file formats (premiére icéne de la barre d’outils). Dans la boite de dialogue, sélectionnez le format
d’export (DHTML, HTML, Excel, CSV, PDF, JOI, XML, Email) et indiquez le nom du fichier.

Pour ce rapport, sélectionnez le format PDF dans la boite de dialogue Export et cliquez sur OK. Acceptez le nom par défaut et
sauvegardez le fichier PDF sur votre bureau. Ouvrez alors le nouveau fichier PDF qui se trouve sur votre bureau.
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Formula One e.Report Designer fournit des rapports au format PDF.

Formula One e.Report Designer est capable de produire des rapports au format PDF, tout en conservant une haute résolution.

Vous pouvez également essayer une procédure similaire pour exporter le rapport au format DHTML, qui propose de loin une
meilleure résolution et une meilleure clarté que le format HTML, en raison des possibilités de positionnement absolu du DHTML.

8. Application Data Handler

L’'aspect unique de Formula One e.Report Designer est sans doute la facilité avec laquelle il peut étre utilisé pour générer des
rapports depuis des données d'objets au sein de votre application Java. Formula One e.Report Designer utilise un mécanisme
de (mapping) objet/structure relationnelle (le Application Data Handler), pour comprendre et extraire les données résidant dans
les objets de votre application Java.

Typiquement, avec l'utilisation de bases de données relationnelles, les utilisateurs sont habitués a travailler avec des concepts
Table/Colonnes. Sion étend ce concept aux objets, on peut penser aux données applicatives en terme d’Objets/Champs
Méthodes, ou la Table est 'objet et les colonnes sont les champs et les méthodes de I'objet. Les données pour votre application
peuvent provenir de n’'importe quelle source ; la seule contrainte est que la donnée soit disponible en tant que classe publique,
ainsi Formula One e.Report Designer peut utiliser 'API Refection Java pour extraire les données et générer un rapport.

©2004 - KAPITEC SOFTWARE S.A.S. - Tous droits réservés - www.kapitec.com
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Le reporting de données applicatives procure de nombreux avantages par rapport au modéle traditionnel de reporting de
données de base de données. Le reporting de données applicatives est particulierement bien adapté pour les applications de
type Internet/Intranet, tout comme pour les applications distribuées. Le reporting de données applicatives peut aussi
énormément réduire la charge de votre base de données, et peut améliorer les performances, et réduire le transfert réseau
inutile de données. Grace a I'Application Data Handler, vous pouvez tirer partie des bénéfices du reporting de données
applicatives tout en conservant la facilité de développement. Les données dans vos objets Java sont accessibles comme si elles
étaient dans une base de données SQL, fournissant ainsi une maniére simple de spécifier les données devant étre montrées
dans un rapport.

9. Fenétre Design

Regardons maintenant quelles sont les caractéristiques du Designer. Pour cela cliquez sur 'onglet Design situé en haut de la
fenétre. La fenétre Design a deux sections principales : la fenétre Structure du rapport a gauche, et le Formulaire Designer a
droite.
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La fenétre Design de Formula One e.Report Designer montre la structure du rapport sur la gauche, et sa mise en page
sur la droite.

Les deux sont congues pour fonctionner ensemble, aussi 'une est dépendante de l'autre. La fenétre Structure du rapport affiche
les différentes parties du rapport : En-téte du Rapport, En-téte de la Page, En-téte du Groupe, Détails, Pied-de-Page du Groupe,
Pied-de-Page de la Page, et Pied-de-Page du Rapport. Dans Formula One e.Report Designer, chacune de ces parties est
appelée "zone". Les éléments montrés a la droite de chaque zone sont contenus dans cette zone. Chaque zone a ses propres
propriétés. Par exemple, une zone En-téte de Rapport est imprimée seulement une fois au démarrage du rapport, etc.

En regardant la fenétre Formulaire du Designer sur la droite, vous remarquerez des éléments avec différentes valeurs texte. De
tels éléments s’apparentent a des “Contrdles”. Certains de ces contrdles sont des étiquettes, alors que d’autres sont des
champs données, des formules, des images, des courbes, etc. Pour en savoir plus sur chacun de ces contrdles, double-cliquez
dessus. Une boite de dialogue multi-onglets contenant leurs propriétés s'affiche alors.

©2004 - KAPITEC SOFTWARE S.A.S. - Tous droits réservés - www.kapitec.com
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Formula One e.Report Designer fournit des possibilités intégrées et pratiques de formatage.

sont affichés.
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concernant votre source de données (noms de table, noms de colonne, type de données de la colonne, valeur par défaut, etc.)
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Le Gestionnaire de Données (Data Manager) de Formula One e.Report Designer vous permet de visualiser la structure

En cliquant sur 'onglet Relationships du Data Manager vous affichez les relations clé primaire-étrangére qui ont été définies

de votre source de données.

entre différentes tables. Les utilisateurs qui travaillent avec des bases de données pensent souvent en termes de

tables/colonnes et requétes SQL. Grace a I'Application Data Handler, les données dans vos objets Java sont accessibles
comme si elles étaient dans une base de données SQL, fournissant un moyen simple de spécifier les données devant étre

visibles dans un rapport.

Dans Formula One e.Report Designer, la requéte qui sera exécutée pour votre rapport est partiellement auto-générée a partir
des éléments que vous avez placé dans la fenétre Formulaire du Designer. Afin de visualiser la requéte SQL basée sur le
dernier état de votre conception, cliquez sur le menu Data -> Section SQL Query Editor. Une boite de dialogue s’affiche alors

avec la requéte a lintérieur.
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Section's Query |

Section ID: |CHARTS |

Guery | Resultset |

SELECT: Ll DIsTINGT

items guantity, items priceguaote, items. description, items arderlD

-

-

FROM: | Table Order..

items

-

-

\WHERE: Auto-generate... | | Build.. |

FY

-

ORDER BY:

ne

|l

Ok ] | Cancel ] | Help

Formula One e.Report Designer vous permet de visualiser et de modifier la requéte SQL pour chaque section du
rapport.

10. Types de Rapports

Formula One e.Report Designer simplifie le développement de nombreux types de rapports incluant :
Rapports tableaux croisés
Rapports multi-tables
Différents niveaux de regroupement
Sections multiples (Maitre-Détail)
Rapports de paramétres

Un rapport tableaux croisés (crosstab report) est un rapport tabulaire dans lequel les données sont présentées comme une
matrice avec des critéres de groupes définis aussi bien sur I'axe X que I'axe Y. De multiples regroupements peuvent étre définis
pour chacun des axes. Chargez le rapport AdvancedCrosstab en suivant les étapes ci-dessous.

Depuis le menu principal, sélectionnez File -> Open. Sélectionnez “No”, si vous y étes invité(e), dans le dialogue de confirmation
de sauvegarde (Load Confirmation). Sélectionnez le fichier crosstab2.jod et cliquez sur “Ouvrir.”

©2004 - KAPITEC SOFTWARE S.A.S. - Tous droits réservés - www.kapitec.com
Formula One est une marque déposée de ReportingEngines, une division d’Actuate Corporation.

-12 -


www.kapitec.com

ﬂem"'mm Guide d’Evaluation de Formula One e.Report Designer

@

EFurmula One e.Report Designer - [crosstab2.jod] - |E||1|

File Edit View Insert Format Data Tools Help

b Design [& Preview |

D B @ X b Fln[=] 2z o A === gad ?2 &
w5 seEBRER0GN 0RDEE
1 . 1 . 2 . 3 . 4 . 5 . 3 ]
RPT_HDR
PG_HDR _
DTL_00 B
categaory
SALESREIS. QUANTITY) = Sum()
FRILESRE "Sum() §Jm[ )
B Total “sum()|  Sum()
PG_FTR - :
RPT_FTR B

<]

[« T

[-]

Licensed Capy T

Formula One e.Report Designer avec le rapport crosstab2.jod en mode conception.

Cliquez sur 'onglet Preview pour visualiser & quoi ressemble un rapport tableaux croisés.

EFnrmula One e Report Designer - [crosstab2.jod] — IDlll

File Edit View Insert Format Data Tools Help

B2 Design [& Preview |

BE [ox-] 44 E &D

Table Of Contents _"""1"""'"2"""'"3"""'"4"""'"5""""'5""""'E|

REPORT N Controller Driver DSP| Dynamic Ram Processor Statit

BIRPT_HDR i

E@_J SEC_00 o | |earajas | Waria 5,893 1,034 18,813 580 2
EIRPT_FTR M 5,803.00 1,034.00 18,813.00 580.00 22,67

o eastito [Pamela 2,175 253 4,009 21,212 587 3

o:a 217500 2,523.00 4,000.00 21,212.00 24§

- | |Firreli Jeff 1,714 G611 1,972 3

i Julie 2,488 1,325 3,206 ] 2

i 420200 1,936.00 5,181.00 3,150.00 3,5
- | |Hemandez |-"'|1ﬂ 7,628 4,248 622 33,484 4,547 k—

7 7,628.00 4,248.00 622.00 33,484.00 4,547.00 32,6

Howard |F‘~”::' 3,125 3,442 1,002 18,500 2 1

% 312500 3,442.00 1,092.00 18,509.00 2,372.00 184

- | Mennings | Leslie 3,935 4102 14,006 728 1

" 383500 4,102.00 14,986.00 728.00 188

) Murphy | Diane 9,908 3,954 258 20,717 1,450 3

: 9,908.00 3,054.00 2,581.00 20,717.00 1,459.00 30,0

© | |patterson WAy 3 1,158 0 15,738 & 2
: Steve 3,993 1 501 760 14,623 785 =
[« | ] E

FPage 1 0f1 Licensed Copy 0.40°, 1.80" 100%

Formula One e.Report Designer avec le rapport crosstab2.jod en mode Apercu.
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Un rapport a sections multiples est congu pour des données dont les tables de la base de données ont une relation Maitre -Détail
logique. Chaque section d’'un rapport a sections multiples a sa propre requéte. Cependant, une telle requéte doit se référer a
des objets dans d’autres sections et créer une dépendance. Chargez et lancez le rapport multiplesections.jod pour voir un
exemple de ce type de rapport. Référez-vous aux mémes instructions que celles que vous avez suivies pour ouvrir le rapport
tableaux croisés.

Eﬁ:rmula One e.Report Designer - [multiplesections.jod] 1Ol =l

File Edit ‘iew Insert Format Data Tools Help

B vesion | [ Prevew |

D@ %8B X v Fliiz]llmz 0 A === HBDHE 2 A
4«50 reEERDNO0EERE A A
| }......---1----.----2----.----3----.----4----.----5----.----3----.---I
RPT_HDR
PG_HDR B
GH_00 B
DTL_00 :
GH_01 _
DTL_01 B : ©  ORDERS.ORDERID " ORDERS.STATUS " ORDERS.ASKBYDATE ORDERS.SH PBYDATE
R : 5 ltem Code
ﬁ_- : : TEMS.TEMCODE  ITEMS.DESCRIPTION
GF_02 _
GF_01 _
GF_00 _ COURTECILISTID & oo I DI i i ::::.....:'I_
— 1] (T (]
| I I \f

L’'onglet Design montre la structure et la mise en page du rapport multiplesections.jod.

Depuis le menu Data, vous pouvez examiner chacune des requétes étant exécutées dans le rapport :
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]
EFormula One e.Report Designer - [multiplesections.jod] - |EI|1|
File Edit Yiew Insert Format | Data | Tools Help
M Desion | [ Preview | section query Editor »|  SEC_CUSTOMERS
o x Connect... Ctrl-T SEC_ORDERS
Eo © ES = ]
DE@E & B2@E X Disconnect SEC_ITEMS E== @8 2/
450 e B & |l ® JDBCDataSource
O ¥ML Data Source
= 4 5. 5
— O Text Data Source
RPT_HDR - =
©  Application Data Source
(| ©  Metadata Data Source
|| O EJBData Source
PG_HDR - o
. ©  Liguid Data - Data Source
GH_00 B Register Data v
DTL_00 ]| RECNUM nm' Load Application Data... (CUSTOMMAME ] CUSTOMERS.PHONE
. |- Export Metadata... CHID P Do e
! . AskBy Dat ShipBy Dat
| .| e Data Source Browser...  Ctl-B S - _ oy A
DTL_01 _ E%I Table Relationships... " ORDERS.ASKBYDATE ORDERS.SHIPBYDATE
GHEYZ . Item Code Description
DTL_02 B ITEMSITEMCODE  ITEMS.DESCRIFTION
GF_02 B - CONIUTEMCODE)
GF_01 B
GF_00 COLNKCUSTIDY ;o -
Sp— 1 [« TR E
f

Formula One e.Report Designer vous laisse visualiser chacune des requétes SQL dans le rapport.

11. Déploiement

Une fois que vous avez fini de développer un rapport, vous pouvez le déployer auprés de vos utilisateurs finaux. Actuate
propose diverses options de déploiement pour répondre a des besoins divers. Par exemple, vous pouvez générer et visualiser le
rapport avec Formula One e.Report Engine au sein d’'une application Java autonome. Vous pouvez également inclure le moteur
e.Report au sein d’'un serveur d’applications, I'appeler depuis une servlet, ou 'encapsuler avec du JSP (Java Server Pages). Il y
a plusieurs exemples de déploiement fournis avec le logiciel. Merci de vous référer aux exemples (C:\Program Files\Formula
One\F1eRE7\Code Samples).

12. Conclusion

Aprés avoir suivi ce guide d’évaluation vous devez avoir une meilleure idée sur la maniére dont Formula One e.Report Designer
fonctionne et sur ses nombreuses fonctionnalités. Et plus particuliérement, sur les fonctionnalités et les bénéfices qui sont
démontrés :

Reporting 100% Pure Java : pas de code natif spécifique a la plate-forme.
Application Data Handler : simplifie le reporting de données depuis des objets Java applicatifs.
Reporting de base de données : rapport depuis des données relationnelles.

Support de nombreux formats dont DHTML, PDF, XML, Excel et CSV : informations livrées dans de nombreux formats
pour répondre aux contraintes des utilisateurs pour la visualisation en haute résolution de contenu.

Fonctionnalités interactives de visualisation : les utilisateurs peuvent facilement trouver les informations pertinentes dans
les rapports grace a la Table des Matiéres.
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Support de types de rapports : tableaux croisés, rapport a sections multiples, graphes/courbes, formulaires, lettres,
rapports de parameétres. Développement basé sur des assistants pour tous les types de rapport les plus répandus
pour une productivité optimale du développeur.
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Annexe : Construction d’'un Rapport

Il s’agit d’'un didacticiel pour créer un rapport depuis le départ en utilisant Formula One e.Report Designer.

e ———

Démarrez e.Report Lancez le designer depuis le menu Démarrer, sélectionnez
Designer Démarrer Programmes / Formula One / Formula One e.Report
Designer - Evaluation
2 Configurez le Driver Ce didacticiel crée un rapport qui a besoin d’un driver ODBC pour
ODBC accéder a une base de données d’exemple MS Access. Merci de

suivre les étapes ci-dessous pour configurer la base de données,
a moins que cela n’ait déja été fait.
- Cliquez sur Paramétres / Panneau de configuration / Outils
d’administration / Sources de données ODBC
- Cliquez sur Sources de données Systeme / Ajouter...
- Sélectionnez Microsoft Access Driver (*.mdb) / Terminer
- Saisissez Sfdata comme nom de la source de données

- Cliquez sur sélectionner le répertoire et naviguez jusqu’au
fichier sfdata.mdb se trouvant dans C:\Program Files\Formula
One\F1eRE7\files\data

- Cliquez sur OK/ OK / OK

3 Connectez la Base A cette étape du didacticiel, on se connecte a la base de données
de Données Sfdata créée dans I'étape précédente.

- Sélectionnez depuis le menu Data / Connect... Vérifiez que
“Detected Drivers” est coché et que
sun.jdbc.odbc.JdbcOdbcDriver est sélectionné. Saisissez
jdbc:odbc:sfdata comme URL de la base de données.
Sélectionnez Apply (Appliquer), puis Close (Fermer).

x
Froperies
¥l Detected Drivers | sun.jbe.odbe.JdbcOdocDriver -]
[[] Other Driver
Database URL |jdhc'mdbc‘5fdata

Passwaord |

|
Username | |
|
|

Select Encoding... | [

Tahle Filter
[¥] Select tables from the list Select Tahles ‘
[ Al takles from
Connected
| Apply ‘ | Close | | Help |
4 Créez un Nouveau Créez un nouveau rapport en cliquant sur l'icobne Page Blanche a
Rapport gauche de la barre d’outils ou en sélectionnant dans le menu File |

New.
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5 Sélectionnez un - Dans la boite de dialogue “New Report”, choisissez “Multiple
Style de Rapport Table”.
- Cliquez sur OK.
x
Report style
Select the type of repart ta create from the list below, then choose
Ok
Reports Preview
Bl Blank Repart
Bl simple Report Groups
El Multile Table e
B Impart Guery
Bl CrossTah
El Lakel Report
Create a reportwhich uses multiple tables. You can create reports
with groupings
| [8]34 ‘ | Cancel ‘ | Help ‘

6 Sélectionnez les Une fois l'assistant Multiple Table Report lancé, cliquez sur Next
Champs de la Base pour commencer a créer le rapport. Sélectionnez les champs pour
de Données pour le ce rapport en sélectionnant le champ et en 'ajoutant avec la fleche
Reporting pointant a droite.

Sélectionnez les champs depuis la table items :
- description
- pricequote
- quantity
x
l_OInfnrmalmm | Fields I Group I £ sort I & Joins 1 Data 1 £ Format |
Selectfields for detail zone
Listed helow is a working set of all tables and their respective columns. You may select one or
mare tableffield and add it ta the list of tables/fields to be inserted into the repart
Select
Waorking set Fields in report
- FJuitanles (= - [literns
)»custumers description
}llems priceguote
itemeode — quantity
description |;J
& pricequote | o>
quantity
categony | N ‘
orderlD -
o~ [ offices |J
o~ [ orders [
)-plan 5
| Hen | cancel || <pack || met> || Fnisn |

7 Sélectionnez les - Cliquez sur Next pour sélectionner Grouping

Regroupements - Groupez par customers.customName et par orders.orderid.
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I
| @ mnomation | & Felss | 85 oroup | &) sont | & Joins | B Data | B8 Format |
Select fields for grouping

There are two lists shown below. On the left, the list shows a set of fields which can be used fo
group the data in the report. You may group the generated report on one or more of these fields.
Simply select the field to he grouped on {in the leff) and add it to the Grouping fields list {on the

right)
Select grouping fields

Working set Grouping fields

[F3All tables

2 custamers.custarnMame:
&~ [fcustomers

2 orders.orderlD

-
&~ [EAplan ‘7
<
& [fsalesreps

& [sm_orders

| Help Cancel H

<gack || News || Finish

Sélectionnez les Cliguez sur Next pour choisir Sorting Criteria.
Critéres de Tri

- Sélectionnez customers.customName, puis orders.ordered, et
enfin items.description comme critéres de tri.

ﬂ
\_omfmmatiun 1 Fields 1 Group | 4| sort I & Joins I Data I B Format ‘
Select sortfields

There are twao lists shown below. On the efl, the list shows a set of fields which have been chosen
1o be inserted inta the report. You may sort the generated report on one or more of these fields
Simply selectthe field to be sorted on (in the lef) and add it to the sort list (on the right).

Select sortflelds

Reportfields Sortfields
iterns.pricequote ® customers customiame
iterns. quantity 2 orders.orderlD

2 iterns.description

Sortorder: |Ascending E

| Help

Cancel H < Back H Mext= ” Finish J

Sélectionnez les Choisissez Auto Detect pour trouver automatiquement les
Jointures les Filtres

jointures, sinon créez & la souris la relation entre les champs d’'une
table & une autre.
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5
mlnfurmalmn | Fields | Group | 4] sort | & Joins [ Data ‘ B Format |

Select joins and edit filters
Click and drag fields from one table {0 another fo create joins amongst the warking set of tables
shown halow.

customers arders items:
custiD Al orderID Al itemcode
(contact_last forecastOrderD: description
contact_first shipEyDate pricecuste
customName forecastshipDet quartity
phone status category
address issus orderlD
city askByDate

state = custiD =

‘ Where Clause I Esract I | Auto Detect J | Clear J

| Hem | cancet || <gack || mea> || mmisn |
- Cliquez sur Next

10

Indiquez le Titre et
le Pied de Page

Dans l'onglet “Data” de l'assistant Multiple Table Report, nous
ajoutons un titre et un pied-de-page au rapport.

- Saisissez “Order Summary” comme titre du rapport.
- Saisissez “Copyright: Any Corporation” comme pied de page.
- Cliquez sur Next.

11

Sélectionnez les
Styles de Rapport

Dans l'onglet “Format” de 'assistant, nous pouvons paramétrer
des premiéres options de formatage.

- Sélectionnez “Divider Lines” pour le style du rapport.

- Décochez “Show Gridlines,” pour désactiver cette
fonctionnalité.

- Cochez “Add Date to report header”.
- Choisissez Finish.

12

Visualisez la
Conception du
Rapport

La conception du rapport apparait dans la fenétre Design. A partir
de cet écran, vous pouvez modifier n'importe lequel des éléments
créés par le Designer.

~laix

Fle Edit View Insert Format Data Toals Help

B Desin | [ Prevew |

D@H & BE@ X vlpu
w50 reBBELREQON0HEE

bl T T4 [RERET-ERT G

RPT_HDR

—
: [Order S 3 ‘

- DateCIDFOR PATE

PG_HOR

‘GHDRO_CUSTOMH, | -
GHDR1_ORDERID ||

SN DMERS CUSTO
5rt11D|RDERS, ORDERI
descption viicaauots oy
=N S.DESCRIPTIC EMSPRICEQUOT: TENS.QUANTITY

oTL_00 -
GFTR1_ORDERID ||

GFTRO_CUSTOMN | -

PG_FTR

RPT_FTR

 [Copyright: 2004

<]

13

Prévisualisez le
Rapport

Cliquez sur 'onglet Preview pour générer le rapport dans la
fenétre Preview. Ouvrez la Table de Matiéres en cliquant sur la
loupe précédante SEC_00.
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i Formula One e.Report Designer - [Untitled*] =1k}

Fle Ecit View Insert Format Data Toals Help

| 2 Desin | R preview |
B&[ex[-] M corn B =D &

Table Of Contents - r T Z : 3 ’ 4 ’ 5 ’ EmE
SIrPT_HOR
sec_o0 - P
e oxia S |
Date:  Feb 17, 2004
stomNavanced Design Cc
orderiD 115
description pricequote quantity
[ 6l x 1 Static Rar 60 361
CesateRam: 1 a5
M x 8 Dynamic R 33 362
6 5t 82 368
B wixa . % a7
arwith 1 itatic 610 366
mmable Video Gri 150 361
\opameRam 3 52 a0
: 4 Statie Ram, 3.2 152 363
[
Page 1 of 52 Licensed Copy 0.00",0.00" 100%

14

Modifiez les
Contrdles dans le
Rapport

Nous référencerons plusieurs contrdles dans une formule et un
graphe plus tard dans ce didacticiel. A cette étape, nous
renommons l'identifiant du contrdle pour qu'’il soit plus facile a
identifier :

- Retournez & la fenétre Design en cliquant sur 'onglet Design.

- Dans la section Detail, double-cliquez sur le contréle ltems.
Description et renommez I'ldentifiant du Contréle en
Description.

- Cliquez sur OK.

Suivez les mémes étapes pour :

- Renommer les identifiants Items.Pricequote en Price, et
Items.Quantity en Quantity.

15

Utilisez les
Formules

Ensuite, nous allons ajouter un champ formule dont la valeur sera
calculée :

- Ajoutez un Label Control aprés Quantité dans Group Header

en sélectionnant 'icéne Label Aa dans la barre d'outils. Le
libellé de I'étiquette doit étre : Total.

- Etirez et positionnez I'étiquette comme nécessaire.

i Formula One e.Report Designer - [Untitled*] ] 3

File Edit View Insert Format Data Tools Help
& Desin | [ Freview |

DB dmeX o BIUAD
4«E0rseBEBERDN0EDEARM

RPT_HOR . \Ol'der Summary. \
Tt (G AR PATE L1 G i

]
1]
]
]
]
B

PG_HDR

oD ERS CUSTONL - B
©1 ordefROERE. OROER] ©:
destription inficauote quantity o3 - Total - 8
1 SME.DESCRIPTIC : EME PRICEGUGT: TTEMS GUANTITY .

GHORD_CUSTOMH,

GHOR1_ORDERID

DTL_00
GFTR1_ORDERID

My T T

GFTRO_CUSTOMH | -

PG_FTR

RPT_FTR 71 ‘ Copyright 2004:

[{]

8 e

LBLO0O [1 Control(s)] 438", 0.24' 070", 0.20° T

3]

Ajoutez une formule dans Detail Section (DTL_00) :

- Sélectionnez licone formule A dans la barre d’outils et
cliguez dans la section Detail, sous la nouvelle étiquette “Total”,
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pour insérer la formule.

Formula specification dialog |

Details

Type in a formula here:

price * guantity

Reset after zone: |DTL_IJU IE“
| Change Farmat... ‘ |$: |
| QK ‘ | Cancel ‘ | Help J

Insérez une formule pour calculer la valeur totale pour chaque
produit. Nous utilisons les identifiants renommeés, quantité et prix,
dans la formule.

- Dans la fenétre Formule, saisissez price * quantity (Appuyez
sur le bouton pour voir le Générateur de Formules).

- Cliquez sur Change Format et sélectionnez Currency (devise)
/ Number.

- Cliquez sur OK.

- Double-cliquez sur la nouvelle formule et renommez
l'identifiant du contr6le en ‘Total'.

- Prévisualisez le rapport.

[ Formula One e.Report Designer - [Untitled*] =10 x|

File Edit View Insert Format Data Tools Help
[ ¢ Desion | [ Preview |
B o[- 1« rn E D &

Table Of Contents p R - H - EEEERE E) EERERE] — 1]
[ErerorT e
{pevuw

&lsec o0 ;

FReT_FR [Order S y |

Date:  Feb 18 2004

storniNavanced Design Ce
orderld ___1115
: description pricequote quantity Total
" 6 % 1 Static Rar 60 361 521,660.00

« 4 Static Ram, 3.2 132 365 $48,180.00

i x 8 Dynamic Ri 33 362 $11,946.00

N Gl x 8 Static Rar 82 368 §30,176.00
s i x 9 Dynamic R 39 367 §14,313.00
. 2rwith 16M Statie 610 366 $223,260.00
mmable Video Gr 150 361 §54,150.00

1 Dynamic Ram, 3 52 370 $19,240.00

(4 staticRam, 3.2 152 363 $55,176.00

[T 40l x 4 Static Rarr 15 368 $5,520.00

o , " g

Page 1 of 52 Licensed Copy -0ao oo 100%
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Formatez le rapport

Ensuite, nous modifierons le design du rapport pour améliorer le
"look-and-feel" des rapports.

Pour modifier la taille du contréle :

- Sélectionnez la formule Total, appuyez sur Ctrl et
sélectionnez le libellé Total. Faites un clic droit, choisissez
Alignement, Make Widths Equal et ensuite Left Edges.
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[§iFormula One e.Report Designer - [Untitled*] =1of x|
File Edit View Insert Format Data Tools Help

DER sR@X o BIU AR
w«BoseEBaR@ONO0EDEAEA

BEA ?&

] z = - 4

== ]
AL [Order Summary : HHERE HHH

Date: GO FOR_DATE

]

PG_HDR.

TomiaDNERS CUSTON
oD RDERS, ORDER s L
description: pricaquote oty & Total &

‘GHDRO_CUSTOMH,
GHDR1_ORDERID

(v vEnma |

oIL 00 | =15 DESCRIPTIC. EM S PRICEQUGT |TENS GUANTITY HICE DB oy
— > g > il Muttiple Selection | et
Lo Left Edges Alighment L] ey
GFTRO_CUSTOMM, | - Right Edges Fonts and Colors...
Tl Style and Alignment... [
- Top Edges Border €. | et
Make Sizes Equal Copy Selection
Make Heights Equal Cut Selection
Make Widths Equal
Stretchin cells =l
0 | o
LBL000 [2 Contral{s)] 438", 024" 070, 0.20" T

Paramétrage de l'alignement :

- Sélectionnez le contrdle ltems.description et appuyez sur

l'icone justifier & gauche
- Etirez par la gauche le contréle Description pour étendre la
largeur du champ.

- Ajustez le libellé Description dans le Groupe Header pour qu'il
corresponde a la nouvelle largeur.

- Etirez également les lignes dans la zone Group Header pour
couvrir le nouveau libellé total et la longueur du champ
description.

- Sélectionnez le contrdle Total Formula, le contréle Price Data,
et le contréle Quantity Data et appuyez sur l'icdne justifier a

droite

- Dans Customer Header Zone, sélectionnez et supprimez le
libellé customName.

- Sélectionnez le contrdle Customers.Customname data et
étirez-le par la gauche pour élargir le champ.

- Sélectionnez le contrdle Customname data et appuyez sur

l'icone justifier & gauche
- Prévisualisez le rapport.

[iFormula One e.Repart Designer - [Untitled*] =1of x|

Hle Edit View Inserl Format Data Tools Help

o Desion | [ Provew |

= e (- | Bh &
Table Of Contents | T~ T z ¥ T w DR 5(-)
[EnreroRT
BIRPT_HDR
%g:i:ﬁﬁ . ‘Or der Summary ‘
Date:  Feb 18, 2004
Advanced Design Corp.
orderlD 1115
description pricequote quantity Total

M 160 x 1 Static Ram 60 361 $21,660.00

16M x 4 Static Ram, 3.3 132 365 $48,180.00

160 x 8 Dynamic Ram 33 362 §11,946.00

16M x 8 Static Ram 82 368 $30,176.00

o 160 x @ Dynamic Ram 39 367 $14313.00

: 324t Controllerwith 161 610 366 $223,260 00

32 bit Programmable Vic 160 361 $54,150.00

320 x 1 Dynamic Ram, 52 370 $10,240.00

320 x 4 Statie Ram, 3.3 182 363 $56,176.00

[+ 4N x 4 Static Ram 15 368 $5,520.00
E 0 4N ¥ 4 Static Rarmn, 3.3y 30 ] 365 $10,950.00 E
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17

Visualisez la
Requéte SQL

Maintenant, nous allons revoir la requéte SQL générée
automatiquement par le Designer :

- Pour visualiser la requéte SQL, sélectionnez Data -> Section
Query Editor -> SEC_00 :

Section's Query x|

Sertion ID: [SEC_00

Query | Resultset |

SELECT: I DISTINGT

orders orderlD, customers.customiame, fterns pricequote, tems.description, fters. quantty

[

FROM: | Tanie orger

orders, customers, items

WHERE Auto-generate J | Build...

orders orderlD = itens orderlD and arders. custlD = customers custD

ORDER BY-

customers.custoranme, orders.ordenD, tems descriptian

CIER] [ ) e

oK I Cancel Il Help

18

Renommez la
Table des Matieres

- Renommez Section ID en Customers.
- Cliquez sur OK.

section's Query

Dans cette étape, nous allons renommer le titre par défaut TOC
pour montrer que les sections du rapport sont listées par
Customer :

- Sélectionnez Data -> Section Query Editor-> SEC_00.

Section ID: [CUSTOMERS

SELECT. I DISTINGT
orelers orderD, customer  iterms , iterms.

. iterns quantity g

FROM | Tabie order.

orders, customers, items

WHERE: auto-generate.. | | Build...

orefers.orderD = items.arderD and arders.custiD = customers.custiD

ORDER BY:

customers.custamiarme, orders.orderD, iterns. description

I 112 Y 3 €/ Y

| oK I cancel I Help

- Prévisualisez le rapport.
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[EiFormula One e-Report Designer - [test.jod*] -[0/ x|
File Edit View Insert Format Data Tools Help
b Design ‘ [& Preview |
RS o e corn B b &
Table Of Contents | 7 T T T E T k&l TE T ==l
@rerorT M |
T &areT_HoR :
&) CLSTOMERS H
pele : |01'(ler Summary ‘
r &5 avanced Desan | | |~ Date:  Feb 16,2004
& :
& B Advanced Design Corp.
P —— oderld 1115
- 5 Advanced Sol - description pricequots quantity Total
65 Avanced Sol Y
€5 Addvanced So e 160 x 1 Static Ram 60 361 921,660.00
- 5 Advanced Spe N
- B3 Exitan Dsign o : 161 x 4 Static Ram, 3.3 132 365 $48,180.00
L &= Compusocrds - 16M x 8 Dynamic Ram 33 382 §11,846.00
» B2 Compuesian Go. : 161 x 8 Static Ram 82 36 $30,176.00
o~ &5 CompuEngineering | |- 164 x 9 Dynamic Ram 39 367 $14312.00
- B2 CompublcraSystem | |~ 32 bt Controller with 161 610 366 3223,260.00
o~ & Com : 2 bt Programmable Vic 150 361 85415000
>~ G5 Computer Engineer | (7 320 x 1 Dynamic Ram, 52 370 $19.240.00
5 Computer Engineeri - 32M x 4 Static Ram, 3.3 152 363 $55,176.00
-85 Computer MicroSys | | 411 4 Static Ram 15 368 $5,520.00
-~ 5 Computer Systems R
: 4Mx 4 Static Ram, 3.3 30 365 $10,950.00
o= @5 Design Boarcs -
- PN &bt Em 43 368 $15,824.00 =
I " TE | ]
Page 1 0f 52 Licensed Copy 0.00, 0.00° 100%

- Retournez a la fenétre Design.

19

Ajoutez un Graphe
dans le Rapport

Maintenant nous allons ajouter un graphe au rapport.

- Etirez Group Footer GFTRO_ORDERID vers le bas de la
page (hauteur d’environ 3 pouces).

- Insérez un graphe en cliquant sur 'icone graphe ﬂ dans la
barre d’outils et ensuite en cliquant dans la section Group
Footer GFTRO_ORDERID. L’assistant de courbes se lance

alors.

- Sélectionnez Next pour commencer a travailler avec
I'Assistant de Courbes.

- Sélectionnez 2D Vertical Comparison Bar Chart’ et cliquez

Chart Properties x|
@ information | BATwe [ [ cads [ 1 voads | B Atributes |
Select a chart type
Listed below are a set of charttypes. Please identify the type of chart that you would like to create
Chart hpes
Line Chart
2D Horizontal Comparisan Barchart 2D Horizantal Stacked Barchart 3D Verlical Gomparison Barchart
30 Horizantal Comparisan Barchart 3D Horizontal Stacked Barchart 20 Pie Chart
< 1 D
[ Hem [ cancer | [ <Bark |[ wex- |[ mmsn |

- Sélectionnez ‘Description’ pour I'axe X et cliquez sur Next.

- Sélectionnez ‘Total’ pour 'axe Y et cliquez sur Next.

- Ajoutez un titre & la courbe : Product Totals by Order.

- Cliquez sur

Finish.

- Etirez la courbe sur toute la largeur et la hauteur de la page
de la zone Order Footer.

- Prévisualisez le rapport ;
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jod*] I
Fle i View lnsert Format Data Tools Help
B Design | [ Prevew |
RS [uwx[] 4 «2» N B0 &
Table Of Contents | | T oA ettt
[ERERORT: [ 16M x 1 Static Ram 60 361 $21,660.00
BT e 5 $48,180.00
Blcustoners a2 36
SR £ Y 32 31,946.00
& 6 3017600
L s a7
610 306 52232
150 w95
B 52 37
. 152 w3 $EAT600
[ 15 368 $5,520.00
a0 %5 $10950.00
B s 38 31582400
: 2 a0 $7.02000
L 848 Dynamic Ram n 35 $1204500
. Product Totals by Order
sgo  dem N gy 100
o yveys =
o) £
Page 1 (at) 88 Licensed Copy 000, 1807 100%

20 Exporter le Rapport Le rapport généré peut étre exporté dans plusieurs formats. Lors
Généré . o L q-
de la prévisualisation du rapport, appuyez sur l'icbne Export
pour afficher les choix de format d’export.
X
Supported export formats
i@ DHTML = HmL
— — b
qﬂj Excel [_J‘ﬂ CEV
% FDF @!ﬁ ol
2] i = =
| Canel ] | Help
21 Sauvegardez la Le design du rapport peut étre sauvegardé en cliquant sur File ->
conception du Save ou File -> Save As.
rapport
22 Fin Fin du didacticiel.
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